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1.0 Introduction 
1.1 Purpose and Functions 
 
The EIA-176 Query System is a PC-based system for users to produce reports and extract data from the 
Energy Information Administration (EIA) form, ‘Annual Report of Natural and Supplemental Gas Supply 
and Disposition’ (EIA-176) database that is used to produce the Natural Gas Annual (NGA) publication.  
Its purpose is to provide users with annual company-level data as reported to EIA, in a format similar to the 
survey form for individual companies, as well as in files suitable for tabular calculation. 
 
The query system has two functions: 1) to provide individual company level responses in a format that 
resembles the EIA-176 filings. This is viewable on-line, and available in a printed form. A blank sample of 
the form EIA-176 form is available on the EIA web site at 
http://www.eia.doe.gov/oil_gas/natural_gas/survey_forms/nat_survey_forms.html.   
 
2) to provide files of the EIA-176 data in a variety of output format that may be imported into various 
software packages. The query system provides two methods to obtain tabular data. The first is a set of 24 
pre-selected queries.  The information in these queries was designed to satisfy the most commonly asked 
questions received by the EIA. Appendix B outlines the pre-selected queries and their respective data items.  
 
The second method is Custom queries. These queries offer users the ability to access sets of data items not 
included in the pre-specified queries. Appendix C outlines the available data items. Data in the pre-selected 
and user-selected queries includes adjustment entries made by EIA staff to ensure that form EIA-176 and 
NGA publication data balance. 
 
Data sets from both query methods can be saved to separate files in a variety of popular formats that 
include: text, comma-delimited for spreadsheets, SDF files for use with dBase, and fixed width format for 
use in other software packages.  
 
New in the pre-selected query section is a report of Name/Address data and a report detailing individual 
company items shown in the continuation pages of the form.  
 
 
1.2 Hardware and Software Requirements 
 
The minimum hardware requirements needed to install and use the EIA-176 Query System are:   
•An IBM-compatible personal computer (PC) – minimum Pentium 75 is suggested and 24 MB of RAM 
•The Windows operating system 95, 98, 2000, or NT –4.0 Service Pack 3 or later) 
•Internet Explorer 5.0 or higher 
•An 80-column monitor 
•15 MB of hard-drive space 
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2.0 Installing and starting the EIA-176 Query System  
2.1 Installing the EIA-176 Query System 
 
To install the EIA-176 Query System on your PC:  

1) Download the software from the EIA web site.  
2) Open Windows Explorer and find the file which is called EIA176Qry2001.exe.  
3) Double click on the file EIA176Qry2000.exe and follow the instructions. 
4) As the installation begins, a ‘Welcome’ screen is displayed. Click the ‘Next’ button to continue.  
5) The ‘Select Destination Directory’ screen will be displayed. Click the ‘Next’ button if you wish to 

continue the installation to the default directory – C:\Program Files\EIA176Qry. If you wish to 
change the default directory, click the ‘Browse’ button.  

6) The ‘Ready to Install’ screen will be displayed. To continue with the installation click on the 
‘Next’ button.  

7) A progress bar will appear. 
8) When the installation is completed the ‘Installation Completed’ screen will be displayed.  
Note: In some instances you will be prompted to re-start your  computer to complete the installation. 
This is normal and can be done immediately to use the query system, or later if so desired.  
 

2.2 Starting the EIA-176 Query System 
 
The query installation program creates a program group and a desktop icon for the EIA-176 Query System. 
The desktop icon starts the query system up immediately and appears on the desktop after the install 
program runs. 
 

 
 
The program group, which is available through the START menu has the EIA-176 Query System icon, as 
well as an option to Optimize (Compact and Repair) the query system.  
 

 
 
The Optimize option should be run periodically so that the query database does not become fragmented.  
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3.0 Using the EIA-176 Query System 
 
After a successful installation the query system can be used to print off individual company 
submissions or to generate data files from the Windows desktop by clicking the START button, 
then the Programs button.  Select the EIA Applications items, and then click EIA-176 Query, and 
the Main Menu Screen of the query system is displayed, as show below:  
  
3.1 Main Menu                

 

 
 Query Main Menu  

 

The three main options available in the EIA-176 Query system are accessed via 
this menu. They are: 
 
View form EIA-176 Respondents: Click this to choose individual company respondents 
and view or print their submissions 
 
Query EIA-176 Data: Click this to choose pre-selected or user selected queries which will 
allow the user to save data to PC-compatible file 
 
Exit: This closes the EIA-176 query application. 
 
Each option is described in the sections that follow. 
 

 

 
3.2 View EIA-176 Respondent  
 
The View EIA-176 Respondent option provides the ability to view individual company filings, including 
footnotes and detailed continuation lines for gas shipped across state lines. 
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3.2.1 Select a Company                   
 
After clicking the View EIA-176 Respondents button on the Main Menu, the following Choose EIA-176 
Company Screen is displayed. To select a company to view first select the report year. Then a retrieval 
method 
 
 

 
View respondent – Choose Company 

 
Select a Company by Name results in an alphabetic list of EIA-176 company names. Since many 
companies do business in multiple states the state code is also shown.  
 
Select a Company in a State in this tow part selection you first select a state, then companies within 
those state(s).  
 
 
3.3.2 Select a Company in a State  
 
Initially a list of states is displayed. Note: that multiple states can be selected. 

 

Highlight the desired state(s) and use the single right pointing arrow  located in between the two 
white boxes to move the state to the selected box.  
 
To remove a state from the selected box, highlight it in the selected (leftmost) box and use the single 

left pointing arrow  to move the state out of the selected box.  
 
Once state(s) have been selected,  click on the Select Company button to see available companies 

within that state.  

Select a report year 
 
Select a retrieval method 
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Use the mouse to select the desired company in the Companies available box. Click the right pointing 

arrow to move it to the selected box on the right.    
 
 
 
3.2.3 Select a Company by Name 

 
View Respondent – Select a Company by Name 

 
Example: El Paso Natural Gas has been selected in the screen above.  
 
3.2.4 View and Print EIA-176 Respondent Submission 
 

To view their submissions click the View=> 
button.  
  
To print a submission without previewing it 
click the Print Selection button.    
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View Respondent result – Preview screen 
 

Clicking on the resize button in the upper right corner can maximize the preview screen.   
                                                                     Click here to maximize the preview window. 

 Clicking on the spyglass will increase the magnification of the screen. 
View subsequent pages of the preview screen by clicking the navigation buttons at the bottom of the 
screen.  
 

       
Arrow Movement 

 Moves to the next 
page 

 Moves to the last page 

 Moves to the previous 
page 

 Moves to the first page 
 A page number can be 

entered directly into 
the middle box. 

  
3.2.5 Exiting the Respondent Submission screen  
 

To exit the respondent submission screen click on the Close  button on the menu bar. The 
Select Company screen will appear.  
 
 

Note: If multiple respondents 
have been selected the select 
Company screen will be 
displayed again before the next 
respondent preview screen 
appears.  
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3.4 Query EIA-176 Data 
By selecting the Query Menu from the Main Menu the Query Menu screen will be displayed.  
There are two query options: Pre-selected, and User-selected.  
 

 
Query Menu screen 

 
The Pre-selected Queries option offers 24 predetermined queries that can be run on all or selected 
companies. The queries and the data items they include are explained in Appendix C.  
 
The User-selected Queries option allows users to select other EIA-176 data items for inclusion in data 
fields. They have a structured format. The rows will always be EIA-176 companies; users may select 
column data values.  
 
The following sections will describe these two options. 
 
 
3.4.1 Pre-Selected Queries  
 
To query EIA-176 data select the Query option from the Main Menu. Pre-selected queries are queries 
whose conditions have already been created. These queries save the user the trouble of having to set the 
desired conditions each time he/she wishes to run the pre-set query.  
A list of queries is available in Appendix C.  
 
The first step in the pre-selected queries is to choose the year and company(s) to query. 
 
3.4.1.1 Select a Company Screen  
 
The Select Company screen for the queries is quite similar to that described in the View Respondent 
option which is described in section 3.3.1.  
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Begin by selecting a year in the ‘Please enter a report year:” .  
 

 
Query  Menu – Choose a Company 

 
Select EIA-176 companies to include in queries. All companies can be selected with the Select All 
Companies option. This retrieval method does not appear on the View Respondents menu.  This will 
close this screen and go to the select queries screen. 
 
The same state and company name boxes that were used in the view respondent data are used here.  
 
Once company selections are completed, click the Next=> button to select a query to run.  If the Select 
all Companies option is selected the window closes automatically. 

 
3.4.1.2 Select a pre-selected query 
 

 
Select a Pre-Selected Query 
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A detailed description of each pre-selected query can be obtained by highlighting the query title. The 
description appears in the box titles Query Description.  
 
Select a query by highlighting it with the mouse; click the Run Query=> button to execute the query.  
 

 
 
The status bar is displayed while the query is running. Queries times vary to be displayed.  
 

 

 
Query Output 

Query output is displayed in a grid format. Appendix A shows how to save or filter this using the query 
filter menu. 
 
3.4.2 Custom Queries 
 
 

The blue bars 
show query 
progress. 
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3.4.2.1 Select Companies and Year. 
 
  This screen is similar to the Company selection screen in other parts of the query.  The Select All 
Companies option is the fastest way to select data from all companies.  
 
3.4.2.2 Select Reported Data items 
 
Once companies and the year are selected, click on the Select Reported Data Items button. A a list of 
data items to pick from will be displayed. 

 
User-Selected Queries – Select Reported Data Items 

 
Each line item with data from the form is represented with a short description. The Part 
and Line Number is also included. The highlight method is similar to that in the 
Company screen. 

 
 
 

Once data items have been selected click on Finished Selecting to go on. 
Appendix C has a detailed description of each of these data items. 

The next selection is:  
 

3.4.2.3 Select Quantities and build Calculated Items  

1) Aggregate 
functions 
2) Select 
Company/Gas 
Activity Type 
2) Available 
Quantities. 
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Available Quantities: 

Select Quantities and Build Calculated Items – Available Quantities 

 
For each line item selected this portion of the screen will have a row.  
 
The Available Quantities portion shows what quantities are available for this item.  
 
The Quantities to include portion allows quantities to be included or excluded. 
.  
In this example, the Number of Consumers for deliveries to Residential Sales is deselected by clicking the 
check box. Number of Consumers won’t appear in the query data file 

Company Type/Gas Activity 

Select Quantities and Build Calculated Items – Select a Company Type 
 
Multiple Company Types and Gas Activity types can be selected. If no selection is made all types are 
included. If they are all included they are not identified. 

Aggregate functions 

Select Quantities and Build Calculated Items – Aggregate function 
 
The Aggregate functions provide summary statistics over all the companies that have been 
selected. The Aggregate functions and the Gas Activities and the Add calculated functions are 
mutually exclusive.  Use the Aggregate Group by Variables instead of the Select Gas Activities 
with Aggregate functions.  

If you select 
Aggregate functions 
then Aggregate 
Group by variables 
become available. 

Click to 
remove this 
from your 
output 
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Output of a query using a summary option  

 
Add a Calculated Field 
 

 
Select Quantities Screen – Make your other selections before opening the Add a Calculated field button 

 
 
To Add a Calculated Field make quantity selections first, and don’t select an Aggregate function. Then 
click on the Add a Calculated Field button.  This opens another window:  
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User Specified Queries – Build calculated Items 

 
The variables selected appear in the Available EIA-176 variables window. They can be added to the 
expression by clicking on them with the mouse. The operators to use in the expression are in the upper 
right. 
 

 

 

When a variable is clicked in the  
Available box, it will appear in the expression box. 
 
 
Click on operators to specify the calculation. 
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Complete the expression 

When the 
expression is 
completed click on 
Complete 
Expression  
to finish. 

 

 
Name the new expression 

Enter a 
Column 
Name in 
the box. 
 
  

Add another expression by clicking on Add Another Expression=>, this will clear out the expression box to 
receive another  expression. The first expression will be held for the query.  
Click Finished=> Run Query when completed. This will immediately run the query. 
 
Note: clicking on the box and using the keyboard can edit Expressions in the expression box.  
Check syntax carefully and use parenthesis when needed. Type variable names exactly as they 
 appear in the Available Variables box, including the square brackets [ ]. 
 
. 

 
Calculated variables appear at the far right of the query grid.  

 
 
User-Selected queries are saved in the same way as pre-selected queries, using the File Menu option. See 
Appendix A for more detail. 
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3.4.3 Exit the User Selected Query Menu 
 

 
Closing the query returns control to 
the User Selected Query Menu.  
 
 
 
Run Query executes the most 
recently constructed query.  
 
Exit returns to the Main Query 
Menu. 

 
 
 



 

APPENDICES
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Appendix A – EIA-176 Menus  

View Company filing Menu 
The View EIA-176 Company Menu offers options for controlling the display of individual company 
filings 
.  

 
 

 – Closes this application. 

  – Choose a printer and set the page orientation (portrait works best). 

 – Changes the magnification of the report.  

    – Sends the report to the printer. 

– Closes this report and either shows the next report if more than one has been  selected more 
than one, or returns to the Choose Company screen.  
 
 Choose Company Arrow Functions 
 
Below is a summary of what the arrow buttons in the Choose and EIA-176 Company do:  
 

 

 
Move the highlighted item in the left box to the right 
box. 
 
Move all the items in the left box to the right box. 
 
Moves the highlighted item in the right box to the left 
box. 
 
Move all the items (highlighted or not) from the right 
box to the left box.  

 
 
Query Menu Functions               
 
Menu items available with the Pre-selected and Custom queries are used to filter output, or export to 
other data formats.  
 

 
File 
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Close – Closes the query grid. 
Save As/Export –Saves the data to another file 
Page Setup – Choose print settings 
Print Preview – Shows what a printout will 
look like 
Close Spreadsheet – closes the query grid 
Print – prints the query grid 
Exit – Quits the Query system. 
 

 
Close – Exits the select query window. 
Save As/Export - option opens an intermediate box. 

 
Intermediate output box from the Save As/Export Datafile menu option. 

 
After the Save As/Export option has been selected an initial ‘Save As’ dialog box opens. Select the ‘To an 
External File or Database’ option, and click the OK button.  
 

Do not select the ‘Within the Current Database’ option 
 

 
. 
 
Next a Windows dialog box will be displayed. Headers may look better with the Save Formatted option. 
 
The File Name can be edited to a unique name. 
 



 
 EIA-176 Query System User’s Guide     Appendix A                                                  October 2002 

 4

 
Save As/Export dialog box. 

 
Different file type options are available by pulling down the ‘Save as File Type’ list box as shown. By 
scrolling down the list of available file types different formats can be selected including dBase, Excel and 
text. To save into a Microsoft Access database the *.mdb file must already exist. 
 
Once the file has been named and the file type selected click the Export button to finish the operation.  

  
 
Page Setup 
 
This option sets printer and page settings. 

Text files 
may save 
more 
successfully 
by checking 
the Save 
Formatted 
box.  
If you save 
Excel files 
with this 
option the 
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Page Setup Menu option 

 
Note: Landscape orientation is recommended for most query outputs, and can be accessed by selecting the 
“Page” tab.  
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Print Preview  
 

 
Print Preview Menu option 

 
The Print Preview button displays what printed output will look like.  
Print 

 
Print Menu option 

 
The Print button prints the grid off. Some of the queries are large so be ready!  
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Edit Menu 

 
 
To use Find, select just one column by clicking on the column header. The ST column is highlighted in this 
example. 

 
Highlight a column or the entire grid to use Edit Menu options 

 
With the column selected pull down the Edit menu and click on the Find option. 
 

 
Find function of Edit Menu 

 
A dialog box will appear. Enter the value to be searched for. After the value has been entered, click either 
Find First, or Find Next. The grid will advance to the found value.  
 

Click in the circle to highlight the entire 
grid. 

To use the Copy option the grid or column needs 
to be highlighted. The entire grid can be 
highlighted by clicking in the upper left corner 
(circled). Individual columns can be highlighted 
by clicking in the column header.  
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Datasheet Menu – Font option 

 
 

 
The Freeze column options always displays a frozen one column on the screen. 
To freeze columns place the cursor in the desired column. In this example that column is 
COMPANYNAME. 
 

 
Datasheet menu – Freeze columns option 
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Pull down on the Datasheet menu item and click Freeze columns.   

 
Datasheet Menu – freeze columns example 

 
The COMPANYNAME column always 
appears at the left. Even when scrolling to the 
right, COMPANYNAME stays on the screen: 
(notice that the first data column is now 
ComCost instead of ResVol, yet the 
COMPANYNAME column still shows). 

  

 
 
Note: Columns can be ‘unfrozen’ only by exiting the query grid.  
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Datasheet – Sort Ascending 
 

 
Datasheet Menu – Sort Ascending – highlight a column to sort on 

 
To use the sort ascending feature select a column by clicking on the column heading. Pull down the 
Datasheet menu and click on Sort Ascending. The query will be sorted according to the values in the 
selected column. 

 
In the example above the ResVol values are sorted in ascending order, starting with zero. 
 
Sort descending works the same way. 
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With sort descending the largest values appear first.  
 

Saving Query Outputs   
 

 
 
 

The File menu provides options over for query output.  
 
Close – closes the query and returns to the selection screen. 
 
When returning to the selection screen company, year and data item 
selections are still be in place. Any aggregate functions will be cleared. 
 
If you have filtered your output the file will not Save As/Export. In this 
case select the entire grid and copy it. The output can then be pasted 
into a spreadsheet application for saving. When the output is pasted it 
may be necessary to resize the row hights. This is done by selecting the 
spreadsheet grid and clicking on the Format/Rows menu items. 
 
 
 
 
 

 



 

Appendix B 
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Appendix B1 – Pre-Selected Query Descriptions  
 Pre-selected Query Title/ 

Default file name 
Query Description  

 All Consumption items sorted by state 
Qry_AllCon_1 

This query includes company data sorted 
by state for lines 5.4.1 thru 5.4.6 
 and lines 7.4.1 thru 7.4.6. Volumes and 
Number of Consumers are available 
 for all lines. Costs are only available for 
lines 5.4.1 thru 5.4.6. 

 Producers Cost 
Qry_Prod_Cst8t 

This query includes company data for Part 
IV, line 2.1. 

 Company Information 
Qry_NMA_9 

This query includes the Company Name, 
State of Operation - the Type of Company -
Part III 1.0- and the Gas Activities -Part III 
2.0- they reported. 

 Detail level Continuation Lines 
Qry_Continuations 

This query shows continuation lines with 
the company reference for Parts 4 & 5. 

 Consumption Vols sorted by sector 
QRY_ConSrtSec 

This query includes company data sorted 
by sector 
 -Residential, Commercial, Industrial, 
Other Nugs, Electric, 
 and Vehicle Fuel . The query includes 
volumes 
 with delivered and transported items. 

 Consumption Vols ranked nationally 
Qry_ConRank_3 

This query includes company data sorted 
by volume amounts. 
Consumption delivered to consumer items - 
lines 5.4.1 thru 
 5.4.6 are added to consumption transported 
items -lines 7.4.1 
 thru 7.4.6 to rank companies nationally. 

 Consumption Vols sorted by company type 
Qry_ConCT_4 

This query includes company data  
sorted by company type -Part III, 1.0. 

 Consumption Vols ranked by state 
Qry_ConRankST_5 

This query includes Company data sorted 
and ranked by volume amount by state. 
 Consumption delivered to consumer items 
-lines 5.4.1 thru 5.4.6- are added to 
 consumption transported items -lines 7.4.1 
thru 7.4.6. 

 Consumption Prices sorted by sector 
Qry_ConPrice_6 

This query includes prices for consumption 
data - lines 5.4.1 thru 5.4.6 - only.  
Costs are not collected for transported 
consumption sector. 

 Consumption Vols for Gas Activity Type A – 
 Produced Natural Gas 
NewGasAct 

This query includes only companies who 
checked A on Part III 2.0 
 - Gas Activities. It covers lines 5.4.1 thru 
5.4.6 and lines 7.4.1 thru 7.4.6. 
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 Pre-selected Query Title/ 
Default file name 

Query Description  

 Consumption Vols for Gas Activity Type B –  
Gathered 
NewGasActB 

This query includes only companies  
who checked B on Part III 2.0 - Gas 
Activities. 
 It covers lines 5.4.1 thru 5.4.6  
and lines 7.4.1 thru 7.4.6. 

 Consumption Vols for Gas Activity Type C – 
Processed 
NewGasActC 

This query includes only companies who 
checked C on Part III 2.0 
 - Gas Activities. It covers lines 5.4.1 thru 
5.4.6 and lines 7.4.1 thru 7.4.6. 

 Consumption Vols for Gas Activity Type D – 
Purchased 
NewGasActD 

This query includes only companies who 
checked D on Part III 2.0 
 - Gas Activities. It covers lines 5.4.1 thru 
5.4.6 and lines 7.4.1 thru 7.4.6. 

 Consumption Vols for Gas Activity Type E - 
Transported Interstate 
NewGasActE 

This query includes only companies who 
checked E on Part III 2.0  
- Gas Activities. It covers lines 5.4.1 thru 
5.4.6 and lines 7.4.1 thru 7.4.6. 

 Consumption Vols for Gas Activity Type F - 
Transported Intrastate 
NewGasAcrF 

This query includes only companies who 
checked F on Part III 2.0 
 - Gas Activities. It covers lines 5.4.1 thru 
5.4.6 and lines 7.4.1 thru 7.4.6. 

 Consumption Vols for Gas Activity Type G - 
Stored Underground 
NewGasActG 

This query includes only companies who 
checked G on Part III 2.0 
 - Gas Activities. It covers lines 5.4.1 thru 
5.4.6 and lines 7.4.1 thru 7.4.6. 

 Consumption Vols for Gas Activity Type H - 
Stored LNG 
NewGasActH 

This query includes only companies who 
checked H on Part III 2.0 
 - Gas Activities. It covers lines 5.4.1 thru 
5.4.6 and lines 7.4.1 thru 7.4.6. 

 Consumption Vols for Gas Activity Type I - 
Injected Propane 
NewGasActI 

This query includes only companies who 
checked I on Part III 2.0 
 - Gas Activities. It covers lines 5.4.1 thru 
5.4.6 and lines 7.4.1 thru 7.4.6. 

 Consumption Vols for Gas Activity Type J - 
Produced SNG 
NewGasActJ 

This query includes only companies who 
checked J on Part III 2.0 
 - Gas Activities. It covers lines 5.4.1 thru 
5.4.6 and lines 7.4.1 thru 7.4.6. 

 Consumption Vols for Gas Activity Type K – 
Imported 
NewGasActK 

This query includes only companies who 
checked K on Part III 2.0 
 - Gas Activities. It covers lines 5.4.1 thru 
5.4.6 and lines 7.4.1 thru 7.4.6. 

 Consumption Vols for Gas Activity Type L – 
Exported 
NewGasActL 

This query includes only companies who 
checked L on Part III 2.0 
 - Gas Activities. It covers lines 5.4.1 thru 
5.4.6 and lines 7.4.1 thru 7.4.6. 

 Consumption Vols for Gas Activity Type M - 
Delivered for Resale 
NewGasActM 

This query includes only companies who 
checked M on Part III 2.0 
 - Gas Activities. It covers lines 5.4.1 thru 
5.4.6 and lines 7.4.1 thru 7.4.6. 
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 Pre-selected Query Title/ 
Default file name 

Query Description  

 Consumption Vols for Gas Act Type N - 
Delivered Directly to consume 
NewGasActN 

This query includes only companies who 
checked N on Part III 2.0 
 - Gas Activities. It covers lines 5.4.1 thru 
5.4.6 and lines 7.4.1 thru 7.4.6. 

 Consumption Vols for Gas Activity Type O – 
Other 
NewGasActO 

This query includes only companies who 
checked O on Part III 2.0  
- Gas Activities. It covers lines 5.4.1 thru 
5.4.6 and lines 7.4.1 thru 7.4.6. 

 All Part IV Items (Volumes, Costs) 
UqryP4LXALL 

Volume and Costs for all Part IV items for 
1999-2000 

 All Part V Items (Volumes, Costs)  
UqryP5LXALL 

Volume and Costs for all Part V items for 
1999-2000 
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Appendix B2 – User Selected Query Item names 
Prt Line 

No 
Description Column  

Name 
Vol Cst Num 

Cnsmr 
BTU Cmp or 

Ref Line

4 0100 Gas Produced onsystem by 
company 

VP4L0100 Y     

4 0210 Gas from producers, gathers, 
processors onsystem 

VP4L0210 
CP4L0210 

Y Y    

4 0220 Gas from pipelines and/or 
distribution onsystem 

VP4L0220 
CP4L0220 

Y Y    

4 0230 Gas from synthetic natural 
gas/SNG onsystem 

VP4L0230 
CP4L0230 

Y Y    

4 0240 Gas  purchased: Comp/within rpt 
ST 

VP4L0240 
CP4L0240 

Y Y   Y 

4 0310 Trans/exch receipts:  Received 
within report ST 

VP4L0310 Y     

4 0320 Trans/exch receipts: Received at 
state line  Comp/ST or Cntry 

VP4L0320 Y    Y 

4 0400 Transported into rpt ST from:  ST 
or Cntry 

VP4L0400 Y    Y 

4 0511  Storage Withdrawals:  Comp-
owned Nat Gas 

VP4L0511 Y     

4 0512  Storage Withdrawals:   Natl Gas 
owned by Others 

VP4L0512 Y     

4 0520  Comp-owned Nat Gas received 
directly from underground storage 
operators 

VP4L0520 Y     

4 0530  Received from underground 
storage operators for the account 
of others 

VP4L0530 Y     

4 0540  Received from LNG VP4L0540 Y     

4 0600  Synthetic natural gas produced VP4L0600 Y     

4 0700  Oth sources of supply VP4L0700 Y    Y 

4 0800 Total Supply VP4L0800 Y     

5 0311 Usd in prcssng: del to cmp plnts 
(Mcf) 

VP5L0311      

5 0100 Used in well, lease, field 
operations 

VP5L0100 
CP5L0100 

Y Y    

5 0200 Returned to oil and/or gas 
reservoirs 

VP5L0200 Y     

5 0312 Plant fuel used in processing VP5L0312 Y     

5 0313 Extraction loss used in processing VP5L0313 Y     

5 0314 Nonhydrocarbons removed used 
in processing 

VP5L0314 Y     

5 0315 Vented Flared, and/or lost used in 
processing 

VP5L0315 Y     



 
 EIA-176 Query System User’s Guide     Appendix B                                                  October 2002 

 6

Prt Line 
No 

Description Column  
Name 

Vol Cst Num 
Cnsmr 

BTU Cmp or 
Ref Line

5 0321 Vol del to plnts redel usd in 
prcssng (Mcf) 

VP5L0321 Y     

5 0322 Total vol used in processing VP5L0322 Y     

5 0411 Storeage Injections: Company-
owned natural gas 

VP5L0411 Y     

5 0412 Storeage Injections: Natural gas 
owned by others 

VP5L0412 Y     

5 0420 Del to underground storage - 
Company-owned 

VP5L0420 Y     

5 0430 Del to underground storage - 
Account of others 

VP5L0430 Y     

5 0440 Added to LNG Storage VP5L0440 Y     

5 0510 Del to other pipelines in rpt state VP5L0510 Y     

5 0520 Del to resellers VP5L0520 Y     

5 0530 Del at state line to:  Comp 
ST/Cntry 

VP5L0530 Y    Y 

5 0541 Del to Residential Sales VP5L0541 
CP5L0541 
NP5L0541 

Y Y Y   

5 0542 Del to Commercial Sales VP5L0542 
CP5L0542 
NP5L0542 

Y Y Y   

5 0543 Del to Industrial sales VP5L0543 
CP5L0543 
NP5L0543 

Y Y Y   

5 0544 Del to Other Non-Utility 
Generators 

VP5L0544 
CP5L0544 
NP5L0544 

Y Y Y   

5 0545 Del to Electric Utility Sales VP5L0545 
CP5L0545 
NP5L0545 

Y Y Y   

5 0546 Del fo Vehicle Fuel VP5L0546 
CP5L0546 
NP5L0546 

Y Y Y   

5 0600 Heat Content of consumer 
deliveries 

VP5L0600    Y  



 
 EIA-176 Query System User’s Guide     Appendix B                                                  October 2002 

 7

Prt Line 
No 

Description Column  
Name 

Vol Cst Num 
Cnsmr 

BTU Cmp or 
Ref Line

5 0710 Trans for other pipelines within 
the rpt ST 

VP5L0710 Y     

5 0720 Trans to resellers for the account 
of others 

VP5L0720 Y     

5 0730 Trans to State Line: Comp 
ST/Cntry 

VP5L0730 Y     

5 0741 Trans to Residential Consumers VP5L0741 
CP5L0741 
NP5L0741 

Y  Y   

5 0742 Trans to Commercial Consumers VP5L0742 
CP5L0742 
NP5L0742 

Y  Y   

5 0743 Trans to Industrial Consumers VP5L0743 
CP5L0743 
NP5L0743 

Y  Y   

5 0744 Trans to Other Non-Utility 
Generators 

VP5L0744 
CP5L0744 
NP5L0744 

Y  Y   

5 0745 Trans to Electric Utility VP5L0745 
CP5L0745 
NP5L0745 

Y  Y   

5 0746 Trans for Vehicle Fuel use VP5L0746 
CP5L0746 
NP5L0746 

Y  Y   

5 0810 Del of Exch gas/storage within rpt 
ST 

VP5L0810 Y  Y   

5 0820 Del of Exch gas to: ST or cntry VP5L0820 Y    Y 

5 0900 Used in pipeline, storage 
distribution 

VP5L0900 Y Y    

5 1000 Other disposition VP5L1000 Y    Y 

5 1100 Total Disposition VP5L1100 Y     

5 1200 Unacc't for gas supply VP5L1200 Y     
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Appendix C  Error Messages 
Error Message Problem/Solution 

 

In the Select Company screen a state 
or company must be in the selected 
box before clicking on View or 
Next=> 

 

In the Select Company screen a year 
must be selected before the retreival 
type is selected. 

 

In the pre-selected query function, a 
query must be selected before  Run 
Query=> is clicked. 

 

In the Custom query option a 
product must be selected before 
clicking on the Finished Selecting 
button. Click  <=Return to exit 
without a selection. 

 

In the Build Calculated Item screen a 
user built calculation must have a 
name. 

 

An error has occurred in the Build 
Calculated Item expression. Start 
over. 
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